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Abstract

The subject of the this final project was to design the steel structures of a machine workshop. The width of the
hall is 31 m, the length 48,5 m and free height 7 m. The load-bearing frame consists of steel columns and
trusses. The work included designing frame bracing, calculating loads and designing the main components. As
bracing methods bracing plate and rigid column were compared. The main objective was to create a structural
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At first, the hall was modeled using the Tekla Structures program, with which an analysis model of the structural
model was created. It was converted to the struxml-format to be opened in FEM-Design using the Tekla StruXML
Export tool. Next, the loads caused by snow, wind and the crane were calculated. Then the forces that come to
the foundations through the diagonals of the end walls were calculated. Finally, the structural elements were di-
mensioned in FEM-Design 17 3d Structure with both bracing methods. The resulting profiles were updated in the
structural model.

As a result, a 3d-model of the hall was completed. The length of the hall leads to a relatively large force transmit-
ted to the foundation by using the diagonals of the end walls. This tends to lift the foundation up, which means
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ALKUSANAT
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kennesuunnitteluohjeena. Haluan kiittda rakennetekniikan yliopettaja Arto Puurulaa ty6ni ohjaami-

sesta. Haluan kiittdd myos Kuopion Konepaja Oy:n hallituksen puheenjohtajaa Risto Finnea mielen-
kiintoisesta aiheesta.

Kuopiossa 21.5.2018
Sami Siivola
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JOHDANTO

Yritys

Taman opinndytetyon tarkoituksena on tehda konepajahallin rakennemalli. Tyon tilaajana toimii
Kuopion Konepaja Oy. Halli rakennetaan Kuopion Kelloniemeen, missa yrityksen omistuksessa on
kaksi vierekkaista tonttia. Tontit yhdistetdan ja tontille rakennetaan uusi tuotantohalli olemassa ole-
van rakennuksen yhteyteen. Uusi rakennus on terasrunkoinen, lampderistetty halli, jota on tarkoitus
laajentaa tulevaisuudessa. Laajennusosa on esitetty kuvassa 1 nimella tuotantohalli 2. Opinndyte-
tyon tavoitteena on suunnitella hallin rakenteellinen jarjestelma, maarittda rakennesuunnittelussa
kaytettavat kuormitukset ja mitoittaa keskeiset rakenneosat Eurokoodi-standardien mukaisesti. Hal-
lin rakennemalli tehd@an Tekla Structures 2017i -versiolla ja rakenneosat mitoitetaan FEM-Design 17
3d Structure -ohjelmalla. Kokonaisuuteen liittyy rakennusarkkitehtiopiskelijan ja talonrakennustuo-
tantoon suuntautuvan insindériopiskelijan opinndytetyét. Insinédritydhon tarvittavat lahtétiedot saa-
daan tilaajalta ja arkkitehtiopiskelijalta.

y
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KUVA 1. Arkkitehtiluonnos rakennuksen laajennusosista

Kuopion Konepaja Oy on vuonna 2010 perustettu metalli- ja kunnossapitoalan yritys. Se tyéllistaa
noin 50 henkil6a ja uusien laitteiden seka tilauskannan kasvun johdosta se tarvitsee lisaa tiloja kas-
vavan tuotantonsa kayttéon. Kunnossapitokoneistuksien ja termisen ruiskutuksen lisdksi yrityksen
erikoisosaamiseen kuuluvat CNC-koneistus, dynaaminen tasapainotus, nivelakseleiden kunnostus

sekd Scotchkotekeraamikomposiittituotteet (Kuopionkonepaja.fi).
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1.2 Lyhenteet ja maaritelmat

Eurokoodi = Kantavien rakenteiden suunnittelua koskeva eurooppalainen standardi.

FEM = Finite Element Method eli elementtimenetelma.

FEM-Design = Strusoftin mallintamisohjelma, jota kaytetadn Eurokoodin mukaiseen betoni-, teras-

ja puurakenteiden suunnitteluun.

Suunniteltu kayttéika = Aika, jonka rakenteen on kestettdva ilman oleellisia korjauksia.

Toinen kertaluku = Toisen kertaluvun laskennassa huomioidaan taipumista syntyva lisamomentti.

U-arvo = Lammonlapaisykerroin eli rakenteen lapdisevan lampdvirran tiheys, kun lampétilaero ra-

kenteen eri puolilla on yksikén suuruinen.

1.3 Yhteistydkumppanit ja tekijanoikeuksien haltijat tai muut tahot

Finne, Risto. Hallituksen puheenjohtaja. Kuopion Konepaja Oy.
Finne, Ilkka. Myyntijohtaja. Kuopion Konepaja Oy.
Jokinen, Merja. Rakennusarkkitehtiopiskelija. Savonia-ammattikorkeakoulu.

Lipsanen, Panu. Talonrakennustuotannon insindédriopiskelija. Savonia-ammattikorkeakoulu.

1.4 Lahtotiedot

Tontti sijaitsee vesiston rannalla ja etdisyys hallin ulkoseindsta rantaviivaan on noin 17 metria. Ra-
kennus on geometrialtaan suorakaiteen muotoinen ja harjakattoinen. Tuotantohallin kerrosalaksi
tulee noin 1500 m?2. Rakennuksen mitat ovat 31 x 48,5 m ja vapaata korkeutta tarvitaan vahintaan 7
metrid. Lisaksi halliin tarvitaan vahintdan yksi siltanosturi. Rakennuksen runko muodostuu teraspila-
reista ja katon padkannattajina toimivista terasprofiileista kootuista kattoristikoista. Ristikon korkeu-
deksi valitaan alustavasti 3000 mm ja pilarin pituudeksi 10000 mm. Pilarijaoksi valitaan hallin pitkalla
sivulla k5400 ja padtyseinalla k5200.

Hallin perustamistavaksi valitaan alustavasti pilarianturaperustus. Perusmuurit tehdadn sokkeliele-
menteista ja ulkoseinat pelti-villa-pelti sandwitchelementeistd. Ylapohjan kantavana rakenteena toi-
mii teréksinen poimulevy, jonka paélle asennetaan hdyrynsulku, ldmméneristeet ja vesikate. Katto-

kaltevuudeksi valitaan 1:16.

1.5 Rungon jaykistys

Rakennejarjestelman valinnassa on otettava huomioon perustamis- ja ymparistéolosuhteet, sallitut
muodonmuutokset ja taipumat, rakentamisen aikainen vakavuus, kustannukset, rakennusaika, ra-

kennuksen laajennusmahdollisuus, liikuntasaumat, tuotantotekniset mahdollisuudet seka laitteiden
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asennusten vaatimat vapaat tilat. Viranomaismaaraykset koskevat esimerkiksi kuormituksia, jayk-
kyytta ja palonkestoa. Kayttajien asettamat vaatimukset vaikuttavat pilarien sijoittamiseen, vapaa-
seen korkeuteen ja erityiskuormituksiin. Rakennukseen kohdistuvat kuormat on selvitettava riitta-

valla tarkkuudella ennen alustavaa mitoitusta. (Kaitila 2014, 117.)

Rakennuksen runkoon kohdistuu vaaka- ja pystykuormituksia. Rakenteet eivat saa menettaa stabili-
teettiaan eli vakavuuttaan. Mahdollisia stabiliteetin menetyksen seurauksia ovat rakenneosan nur-
jahdus, kiepahdus tai lommahdus. Rungon on pysyttava tasapainossa, eika sen rakenteet saa siirtya
tai kiertya jaykkana kappaleena. Runkojdrjestelman vakavuus voidaan varmistaa jaykilla osilla ja lii-
toksilla seka kayttamalla jaykisteita tai koko rungon jaykistavia rakenneosia. Terasrungon jaykistys-
menetelmat voidaan jakaa jaykkaan leikkausvoimia ottavaan levyyn, vaaka- ja pystyrakenteiden vali-
seen jaykkaan liitokseen tai diagonaalisauvojen muodostamaan ristikkoon. Erilaisia jaykistystapoja
ovat kehd-, ristikko-, levy-, masto-, sydan- ja putkijaykistys. Terdsrakenteiden jaykistykseen kayte-
taan yleisesti keha- tai ristikkojaykistysta. Kerrostaloissa kaytetaén usein mastojaykistysta, kun taas

sydan- ja putkijaykistysta kaytetadn esimerkiksi pilvenpiirtajissa. (Kaitila 2014, 117.)

Konepajahallin mahdollisia jaykistystapoja ovat levy- tai mastopilarijaykistys. Levyjaykistyksessa ka-
ton teraksiset poimulevyt muodostavat yhtendisen jaykan levyn, joka siirtda vaakakuormat paatysei-
nien vinositeiden kautta perustuksille. Kyseisessa jaykistystavassa pilarin ja perustuksen valinen lii-
tos voi olla nivelellinen, jolloin pilarin alapdaahdn ei synny momenttia. Mastopilarijaykistyksessa pilari
on kiinnitetty jaykasti perustukseen ja vaakakuormat siirretédn mastopilarien kautta perustuksille.
Pilarin ja katon padkannattajan valinen liitos on molemmissa jaykistystavoissa nivelellinen. Levyjay-
kistyksen etuna verrattuna mastopilarijaykistykseen ovat pienemmat momentit, jotka johtavat hoi-
kempiin pilareihin. Haasteena jaykistystavassa on paatyseinan vinositeen kautta perustukselle tuleva
suhteellisen suuri voima, joka pyrkii nostamaan perustuksen ylds. Perustuksen nouseminen voidaan

estaa esimerkiksi peruspilarien véliin valettavalla betonipalkilla, joka yhdistéan pilarianturat toisiinsa.
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2 HALLIN MALLINTAMINEN

Mallin perustaminen aloitetaan Teklan aloitusndkymassa “New” -valilehdelta. Mallille annetaan nimi
ja tallennussijainti seka valitaan kaytettdva “Template” eli kokoonpano. Tassa tapauksessa kokoon-
panoksi valitaan “Start Model Concrete”. Kayttajatyypiksi valitaan "“Single-user model”, jolloin mallia
voi kayttaa yksi henkilé kerrallaan. “Multi-user model” tarkoittaa tilaa, jossa malli on tallennettu pal-
velimelle ja sitd voi kayttda useampi henkilé yhtad aikaa. Malli luodaan valitsemalla “Create”, jonka
jalkeen ruudulle ilmestyy ikkuna, jossa valitaan ensimmainen 3d-ndkyma. Taman jalkeen malliin voi-
daan tuoda referenssipiirustus tai -malli valitsemalla “Reference Models > Add model”. Tuettuja tie-
dostotyyppeja ovat esimerkiksi dwg ja ifc.

Seuraavaksi aloitetaan “grid” -verkon muokkaaminen kaksoisnapauttamalla verkkoa. Nayttéon ilmes-
tyy ikkuna, jossa muokataan moduuliviivojen valit ja tunnukset. X-suunnassa viivojen valeiksi asete-
taan kehadjako 5400 mm ja y-suunnassa paatyseinan pilarijako 5200 mm. Nykyisen verkon muutok-
set hyvdksytddn valitsemalla “Modify”. Samassa mallissa voi olla myds useita “grid” -verkkoja, jolloin
uusi verkko luodaan valitsemalla “Create”. Lopuksi moduuliverkko voidaan siirtaa esimerkiksi arkki-

tehtipiirustuksen suhteen oikeaan kohtaan “Move Special > Linear” —komennolla.

Moduuliverkon muokkaamisen jdlkeen luodaan tarvittavat nakymat, joita tarvitaan esimerkiksi piirus-
tuksia tehdessa. Nakymat luodaan “grid” -linjojen mukaan valitsemalla “"View > New View > Along
grid lines” ja avautuvasta ikkunasta “Create”. Muita vaihtoehtoja ndkymien luomiseen ovat kahden
pisteen, kolmen pisteen tai tietyn rakenneosan valitseminen. Halutut nakymat valitaan nakyviin
"Views" -ikkunassa. Nakyman syvyyttd voidaan saataa “View Properties” -valikossa ja kohdasta “Ob-
ject group...” paastaan ikkunaan, jossa nakyma voidaan suodattaa maarittamalld ndkyvat rakenne-

osat.

2.1 Perustuksien ja pilarien mallintaminen

Rakenneosat pyritddn mallintamaan Teklassa mydtapdivaan ja vasemmalta oikealle. Pilarianturat
mallinnetaan “Create Pad footing” -tydkalulla antamalla anturan tartuntapiste. Kaksoisnapauttamalla
anturaa paastaan "“Pad footing Properties” -valikkoon, jonka “Attributes” -valilehdellda maaritetaan
anturan nimi, profiili, materiaali, pintakasittely ja objektin vari. Hallin anturoiden profiileiksi valitaan
alustavasti sivuseinilla 1700x1200 mm ja paatyseinilla 1300x1000 mm. "“Position” -vélilehdelld saade-
taan anturan sijainti tartuntapisteeseen ndhden sekd maéritetaén yla- ja alapinnan korot. Yldapinnan
koroksi annetaan -1000 ja alapinnan -1500, jolloin anturan korkeudeksi tulee 500 mm. “Cast unit” -
valilehdella valitaan "“Cast unit type” -kohdasta anturan valmistustavaksi "Cast in place” eli paikalla-

valettu.

Peruspilarit mallinnetaan “Create concrete column” -ty6kalulla antamalla pilarin tartuntapiste. Pilarit
mallinnetaan alhaalta ylds ja niiden korko on aina suhteessa nollatasoon. Pilarien asetuksissa on

muuten samat kohdat kuin pilarianturan asetuksissa, mutta lisana on “"Deforming” -valilehti, jossa



11 (39)

pilarin paat voidaan maarata kiertyviksi tai pilarista voidaan tehda kaareva. Tassa tapauksessa pe-
ruspilarin profiiliksi valitaan 480x480 mm, yldpinnan koroksi -300 ja alapinnan koroksi anturan yla-

pinnan korko -1000, jolloin pilarista tulee 700 mm korkea.

Teraspilarit mallinnetaan "Create steel column” -tybkalulla antamalla pilarin tartuntapiste. Pilarin
profiiliksi valitaan alustavasti HE-A 280 ja materiaaliksi rakenneteras S355J2H. "Position” -valileh-
delld sivuseinan pilarin ylapaalle annetaan tdssa tapauksessa korko +10000 ja alapaalle -300. Pilari
litetdan perustukseen "Base plate” -komponentilla (KUVA 2). Asetuksissa “Parts” -vélilehdelld anne-
taan pohjalevyn mitat ja materiaali. “Anchor rods” -valilehdelld valitaan liitokseen mallinnettavat
osat, niiden profiilit, materiaalit ja etdisyydet. “Bolts” -valilehdella voidaan muuttaa pulttien kokoa ja

reunaetaisyyksia.

KUVA 2. Pilarin liitos perustukseen

2.2 Kattoristikoiden ja palkkien mallintaminen

Kattoristikot mallinnetaan "Truss” -komponentilla antamalla yldpaarteen alku- ja paatepisteet. Risti-
kon geometria muokataan asetuksissa "Picture” -vélilehdella (KUVA 3). Ristikolle annetaan harjakor-
keus, lappeen leveys ja korkeus ristikon padssa. “Parts” -vélilehdellad valitaan paarteiden ja sauvojen
poikkileikkaukset. Yldpaarteen profiiliksi valitaan alustavasti CFRHS 200x200x12,5, alapaarteen pro-
fiiliksi CFRHS 200x200x10 ja sauvojen profiileiksi CFRHS 180x180x8. Ristikon osat voidaan mallintaa
kahdesta profiilista valitsemalla kohta “Twin profiles”. Lopuksi ristikon ylapaarre liitetdan pilariin
""Seating cap plate” -komponentilla (KUVA 4).
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KUVA 3. Ristikon mittojen sydttaminen

KUVA 4. Pilarin ja ristikon ylapaarteen liitos

Hallin vinot paatypalkit mallinnetaan “Create steel beam” -tydkalulla valitsemalla palkin alku- ja paa-
tepisteet. Palkkien asetuksissa on lédhes samat kohdat kuin pilarien asetuksissa. Ainoa ero on "Posi-

tion” -vdlilehdelld, jossa voidaan siirtda palkin paata haluttuun suuntaan tai tehda palkista kaareva.
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Palkki katkaistaan paatypilarien kohdalta "Split parts” -ty6kalulla ja liitos tehdaan “Column - 2
beams” -komponentilla. Myds pilareiden valiin tulevat vaaka- ja vinosauvat mallinnetaan "“Create
steel beam” -tyokalulla. Paatyseindn vinosauvan profiiliksi valitaan alustavasti CFRHS 180x180x8.

Seinien vaaka- ja vinosauvat liitetdan pilareihin “Tube Gusset” -komponentilla.

2.3 Elementtien ja poimulevyjen mallintaminen

Sokkelielementit mallinnetaan “Non_bearing_plinth” -komponentilla valitsemalla elementin alku- ja
paatepisteet. Asetuksien ensimmaisella valilehdella sydtetadn elementin mitat. Elementin korkeu-
deksi annetaan tassa tapauksessa 1900 mm, kuorien paksuudeksi 100 mm ja eristeen paksuudeksi
150 mm. Elementtien nurkkaliitosten tekemiseen voidaan kayttéa esimerkiksi “PC_EW_EW_GR_10" -
komponenttia. Alapohjalaatta mallinnetaan “Create concrete slab” -tykalulla. Laatan paksuudeksi

valitaan alustavasti 300 mm.

Seinien pelti-villa-pelti sandwitchelementit mallinnetaan Tekla Warehousesta ladattavalla “Insulated
Wall Panel Tool” -komponentilla (KUVA 5). Komponentti tuodaan Teklaan valitsemalla “Application &
Components > Manage Extensions > Extension Manager” ja valitsemalla vautuvasta ikkunasta “Im-
port”. Kantavien poimulevyjen profiilit ladataan Tekla Warehousesta, jonka jélkeen profiilit tuodaan
malliin valitsemalla “File > Catalogs > Profile Catalog > Import”, josta padstaan valitsemaan tuotava
profiilipaketti. Poimulevyt mallinnetaan palkkina “Create steel beam” -tydkalulla.

KUVA 5. Seindelementit mallinnettuna

2.4 Tekla-mallin vieminen FEM-Design 3d Structure -ohjelmaan

Avoin tietomalli tarkoittaa eri hankeosapuolien ohjelmistojen yhteensopivuutta. Tekla Structures -
tietomallinnusohjelma on yhteensopiva esimerkiksi mitoitus-, arkkitehti-, kustannuslaskenta-, projek-
tinhallinta- ja tuotannonhallintaohjelmien seka tuotantokoneiden kanssa. Yhteensopivuuden mahdol-
listaa Microsoft.NET -ohjelmistokomponenttikirjastoon perustuva Tekla Open API -ohjelmointiraja-
pinta. Tuettuja standardeja ovat esimerkiksi SDNF, CIS/2 ja IFC. (Tekla.com.)
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Teklan ja FEM-Design 3d Structure -ohjelman valiseen tiedonsiirtoon tarvitaan Tekla StruXML Export
-ty6kalua. Ty6kalu on oma erillinen asennettava sovellus, joka on ladattavissa FEM-Design Down-
load Centerista. Silla muutetaan “Tekla Analysis Model” struxml-tiedostoksi, joka voidaan avata FEM-
ohjelmassa. Analyysimalli perustuu fyysisen mallin geometriaan ja asetuksiin. Laskentamalliin siirtyy
analyyttisen mallin geometria, valittujen rakenneosien poikkileikkaustiedot, valitut materiaalitiedot,
vapausasteet, jaykat liitokset ja moduuliverkko. Analyysimallin asetuksia joudutaan yleensa saata-
maan ennen sen tuomista FEM-ohjelmaan. Mikali tietoa halutaan siirtda toiseen suuntaan eli FEM-
mallista Teklaan, kdytetdan Tekla StruXML Import -tydkalua. Silloin FEM-mallista luodaan ensin uusi

Tekla-malli, johon voidaan mydhemmin tuoda paivitettya tietoa laskentamallista. (StruSoft.)

Analyysimallin luominen aloitetaan valitsemalla “Analysis & design > A&D models > New”, jonka

jélkeen avautuu “Analysis Model Properties” -ikkuna (KUVA 6).

-

Save | | Load V| Save as ‘

Analysis model Analysis  Job  Output Seismic Seismic masses Modal analysis Design - Steel Design - Concrete Design - Timber

Analysis model name: ‘ Model 2 | Browse for export folder
Creation method: ‘By selected parts and loads ~ |

Filter \ None v |

Secondary member filter ‘Auto—detect secondary members e |D Reapply to all parts
Analysis application ‘ v |D Set as the default

Less settings

Use rigid links ‘ Enabled v |
Default keep axis for secondary members ‘YGS v |
Analysis model rules Analysis model rules...

Curved beams ‘Split into straight segments v |
Consider twin profiles ‘Disabled ~ |
Member axis location ‘Neutral axis v |
Member end release method by connection: ‘YGS e |
Automatic update ‘Yes - Physical model changes are considered v |
Model merging with analysis application ‘Disabled v |

0K Cancel Help...

KUVA 6. "Analysis Model Properties” -ikkuna

"Analysis model” -valilehdellad valitaan, etta luodaanko analyysimalli koko mallista vai tietyista raken-
neosista. Lisdksi asetuksissa saadetaan, ettd sisaltyvatko jaykat liitokset analyysimalliin ja missa ra-
kenneosien akselit sijaitsevat suhteessa fyysiseen poikkileikkaukseen. Tassa tapauksessa “Creation
method” -kenttadn valitaan "By selected parts and loads”, “Use rigid links” -kenttaan “Enabled” ja
"Member axis location” —kenttadn "Neutral axis”. Asetukset hyvéksytdan ja edelliseen ikkunaan
paastadn valitsemalla “OK". Analyysimallin rakenneosat valitaan "A&D models” -ikkunasta valitse-
malla “Select oblects” ja "Add selected objects”. Ennen rakenneosien valitsemista ndkymasta kan-
nattaa suodattaa pois rakenneosat, joita ei tulla valitsemaan analyysimalliin. Tassa tapauksessa ana-

lyysimallista jatetdan pois sokkeli- ja seindelementit seka kantavat poimulevyt.
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Seuraavaksi mallissa ndkyvien osien ja solmupisteiden numerot piilotetaan valitsemalla “File > Set-
tings > Advanced Options > Analysis & Design” ja muuttamalla “XS_AD_MEMBER_NUMBER_VISU-

ALIZATION”, “XS_AD_NODE_NUMBER_VISUALIZATION" ja “XS_AD_NODE_NUMBER_BY_Z" -koh-

tien arvoksi "FALSE”. Analyysimalliin liittyvat virheet tarkastetaan valitsemalla "A&D models” -ikku-

nasta “Display warnings” ja avautuvasta ikkunasta “Details”. Virheet johtuvat yleensa siita, etta ra-
kenneosien akselit eivat kohtaa, jolloin osien vdlille ei synny liitosta. Rakenneosan asetuksien muut-
taminen onnistuu kaksoisnapauttamalla sen akselia, jolloin paastdaan “Analysis Properties” -valik-

koon. Akselien sijaintia paastaan muuttamaan "Position” -valilehdelld kohdasta "Axis”. (StruSoft.)

Analyysimallin muuttaminen struxml-muotoon aloitetaan kdynnistamalla Tekla StruXML Export -ty6-
kalu Teklan ollessa taustalla kdynnissa. “Export” -valilehdella valitaan tuotava malli, "Materials” -
valilehdella Tekla-mallin materiaaleille FEM-ohjelman vastikkeet ja “Sections” -valilehdella Tekla-mal-
lin profiileille FEM-ohjelman vastaavat profiilit (KUVA 7). Tiedosto luodaan valitsemalla “Export”,
jonka jalkeen struxml-tiedosto I6ytyy Tekla-mallin analysis-kansiosta ja on avattavissa FEM-Design
3d Structuressa.

,@ Tekla StruXML Export

a X

v

Eurocode (NA: Finnish)

Export | Materials | Sections Code .....

~

Show current sections

Load section library H Reset ‘

» Concrete sections

© Steel sections
Timber sections
Hollow Core

450%450 : Rectangle400x450
CFRHS160X160X8 : KKR160x160x8
CFRHS180X180X8 : KKR180x180x8

CFRHS200X200X10 :
CFRHS200X200X12.5

KKR200x200x10

: KKR200x200x12.5

HEA260 : HE-A260
HEA280 : HE-A280

Connected to Tekla Structures

materials and sections

@ Model 2: Materials and sections collected

Model 2: Collecting current

About  Manual

Cancel ‘ ‘ Export

KUVA 7. StruXML Export -ty6kalun “Sections” -vadlilehti
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3 RAKENTEIDEN KUORMITUKSET

Rakenteiden on kestettdva kaikki todennakdisesti esiintyvat kuormat ja sailytettdva kayttdkelpoisuu-
tensa suunnitellun kayttdian ajan. Lisaksi rakenteiden tulee kestad vaadittu aika tulipalossa. Onnet-
tomuustilanteissa syntyvia suuria vaurioita on pyrittdva valttamaan estamallad jatkuvia sortumia, va-
hentdmalla rakenteisiin kohdistuvia vaaroja ja valitsemalla rakenneratkaisuja, jotka eivat sorru va-

roittamatta. Seuraamukset, kuten ihmishenkien menetykset tai taloudelliset vahingot otetaan suun-

nittelussa huomioon seuraamusluokilla:

» CC3: Suuret seuraamukset ihmishenkien menetysten tai suurten taloudellisten va-
hinkojen takia. Luokkaan kuuluu rakennukset, joissa on suuri joukko ihmisia kuten

yli 8-kerroksiset asuin-, konttori- ja liilkerakennukset seka liikuntahallit.

= CC2: Keskisuuret seuraamukset ihmishenkien menetysten tai merkittavien taloudel-
listen vahinkojen takia. Luokkaan kuuluu ne rakenteet, jotka eivat kuulu luokkiin
CC3 tai CC1.

» CCl: Vahaiset seuraamukset ihmishenkien menetysten tai pienten taloudellisten va-
hinkojen takia. Luokkaan kuuluu 1- ja 2-kerroksiset rakennukset, joissa oleskellaan
vain tilapdisesti kuten pienehkét varastot.

(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 25-26.)

Seuraamusluokkiin liittyy rakenteiden luotettavuutta kuvaavat luotettavuusluokat RC1, RC2 ja RC3.
Luotettavuusluokan perusteella maaraytyy kuormakerroin Kr. RC1-luotettavuusluokassa Kr = 0,9,
RC2-luotettavuusluokassa Krr = 1,0 ja RC3-luotettavuusluokassa Krr = 1,1. Konepajahalli kuuluu seu-

raamusluokkaan CC2, joten kuormakertoimena kéytetéan arvoa 1,0.

3.1 Rajatilamitoitus

Rajatilamitoitustarkastelut tehddan kaikille tarvittaville kuormitustapauksille ja mitoitustilanteille. Eri-
laisia mitoitustilanteita ovat normaalit mitoitustilanteet, valiaikaiset mitoitustilanteet, onnettomuus-
mitoitustilanteet ja maanjaristysmitoitustilanteet. Murtorajatilat ja kayttorajatilat kasitelldan erikseen.
(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 29.)

Kuormat jaetaan pysyviin kuormiin, muuttuviin kuormiin ja onnettomuuskuormiin. Pysyvia kuormia
ovat rakenteiden oma paino ja muuttuvia kuormia lumi-, tuuli- ja hyétykuormat. Hydtykuormilla tar-
koitetaan esimerkiksi henkiloista, kalusteista ja tavaroista aiheutuvaa kuormaa. Muuttuvien kuormien
samanaikaisuus huomioidaan yhdistelykertoimilla (TAULUKKO 1). Kerroin yo on muutuvan kuorman
yhdistelykerroin ominaisyhdistelmdssa, jota kaytetdan murtorajatilassa ja palautumattomassa kayt-
térajatilassa. Kerroin w1 on muuttuvan kuorman tavallinen yhdistelykerroin, jota kdytetdan onnetto-
muustilanteita sisaltdvassa murtorajatilassa ja palautuvassa kayttdrajatilassa. Kerroin w2 on muuttu-

van kuorman pitkdaikaisarvon yhdistelykerroin, jota kaytetdaan onnettomuustilanteita sisaltdvassa
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murtorajatilassa ja palautuvassa kayttorajatilassa. (Suunnitteluperusteet ja rakenteiden kuormat:
RIL 201-1-2017, 31-32.)

TAULUKKO 1. Kuormien yhdistelykertoimet rakennuksille (Kantavien rakenteiden suunnitteluperus-
teet. Suomen RakMK 2016, 18)

Kuorma W 7 5

Hyotykuormat rakennuksissa, luokka (SFS-EN 1991-1-1)
Luokka A: asuintilat 0,7 0,5 0,3
Luokka B: toimistotilat 0,7 0,5 0,3
Luokka C: kokoontumistilat 0,7 0,7 0,3
Luokka D: myymalatilat 0,7 0,7 0,6
Luokka E: varastotilat 1,0 0,9 0,8
Luokka F: liikenngitavat tilat, ajoneuvon paino < 30 kN 0,7 0,7 0,6%*
Luokka G: liikennditévit tilat, 30kN < ajoneuvon paino = 160 kN 0,7 0,5 0,3**
Luokka H: vesikatot 0 0 0
Lumikuorma (katso SFS-EN 1991—1—3)*] kun

se < 2,75 kN/m* 0,7 0,4 0,2

se > 2,75 kN/m’ 0,7 0,5 0,2
Jaskuorma ***! 0,7 0,3 0
Rakennusten tuulikuormat (SFS-EN 1991-1-4) 0,6 0,2 0
Rakennusten sisdinen lampétila (ei tulipalossa) (SFS-EN 1991-1-5) 0,6 0,5 0

* Ulkotasoilla ja parvekkeilla 4 = 0 luokkien A, B, F ja G yhteydessa.

Huomautus: Mik3li rakennuksessa on eri kuormaluokkia, joita ei voi erotella omiin selviin
ryhmiinsa, kdytetaan yrarvoja, jotka antavat epdedullisimman vaikutuksen.

**) pNjokaytavilld v, =0

*#*) K oskee huurtumisesta, jaatdviasta sateesta ja rantisateesta aiheutuvia jadkuormia

3.1.1 Murtorajatila

Murtorajatila tarkoittaa tilaa, jossa rakenteen kestavyys vylittyy ja rakenne sortuu. Terdsrakentami-
sessa tarkastettavia murtorajatiloja ovat jaykan rakenneosan stabiliteetin menetys, rakenteen sisai-
nen vaurioituminen tai liian suuri siirtymatila, maan pettdminen tai liian suuri siirtymatila seka raken-
teen vasyminen. Rakenteita suunniteltaessa on osoitettava, etta tasapainoa heikentavat kuormat
ovat pienempia tai yhtésuuria kuin tasapainoa parantavat kuormat, tai kuormista aiheutuva voima-

suure on pienempi tai yhtd suuri kuin rakenneosan kestavyys. (Kaitila 2014, 33-36.)

Murtorajatilassa rakenneosien kestavyyden tutkimisessa kdytetadn seuraavista lausekkeista epdaedul-

lisempaa kuormitusyhdistelmaa:

115K Gy up + 0.9Gijimg + 15Kz Qs + L5Ker D o1 - Qg
i>1

1;351(FI ij,sup + 0;9ij,inf

missa Gij,sup = epadedulliset pysyvat kuormat
Gu,inf = edulliset pysyvat kuormat

Qk,1 = maaradava muuttuva kuorma



Qx,i = muut yhta aikaa vaikuttavat muuttuvat kuormat
Wo,1 = muun yhtd aikaa vaikuttavan muuttuvan kuorman yhdistelykerroin
(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 53).

3.1.2 Kayttorajatila
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Kayttorajatila tarkoittaa tilaa, jonka ylittymisen jalkeen rakenne ei tayta sille asetettuja kayttdkelpoi-

suusvaatimuksia, jotka liittyvat yleensa rakenteen ulkondkdon. Kayttorajatilassa kuormien aiheutta-

mat vaikutukset eivat saa ylittaa siirtymien, varahtelyn tai mahdollisten vaurioiden raja-arvoja. Las-

kennassa huomioidaan toisen kertaluvun teorian vaikutukset. Kayttorajatilojen kuormitusyhdistelmia

on kolme; ominaisyhdistelma, tavallinen yhdistelma ja pitkdaikaisyhdistelma. Ominaiskuormitusyh-

distelma on:
Z Grj+P+ Q1+ Z Yo,i Qr.i
j=1 i>1

missa Gkj = pysyvat kuormat

P = esijannitysvoima

Q1 = madraava muuttuva kuorma

Qx,i = muut yhta aikaa vaikuttavat muuttuvat kuormat
Wo,i = muun yhtd aikaa vaikuttavan muuttuvan kuorman yhdistelykerroin
(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 44).

3.2 Ylapohjarakenteen omapaino

Ylapohjarakenteen omapaino lasketaan rakennusmateriaalien tilavuuspainojen perusteella (TAU-

LUKKO 2). Ripustuskuormana kaytetdan arvoa 0,2 kN/m?2. Rakenteen U-arvo on laskettu valmiiksi ja

arvoksi on annettu 0,09 W/mZK, joka tdyttaa lampiman tilan yldpohjan Iammonlapaisykertoimen ver-

tailuarvon.

TAULUKKO 2. Ylapohjarakenteen nelibkuorman laskeminen

rakennekerros paksuus | tilavuus- | nelié-
(m) paino kuorma
(KN/m3) (KN/m?)
vedeneristys; aluskermi + pintakermi 0,007 - 0,095
pintakerroseriste PAROC ROB 100 gt 0,03 2,1 0,063
vélikerroseriste PAROC ROS 30 0,14 1,0 0,14
vadlikerroseriste PAROC ROS 30g 0,18 1,0 0,18
héyrynsulku; bitumikermi 0,0035 |- 0,04
PAROC ROS 50 0,05 1,3 0,065
kantava poimulevy, T130M-75L-930, S350 | 0,0015 - 0,19
asennukset - - 0,2
yhteensa | 0,973




3.3 Lumikuorma
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Lumikuorma on muuttuva kiinted kuorma, joka saadaan kaavasta:

missa

§ = p;CeCesyc

Mi = lumikuorman muotokerroin

sk = maan lumikuorman ominaisarvo (kN/m?)

Ce = tuulensuojaisuuskerroin

C: = lampokerroin, joka on yleensa 1,0

(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 100).

Hallin kattokaltevuus on 3,6°, jolloin lumikuorman muotokertoimena kaytetaan arvoa 0,8 (KUVIO 1).

Rakennuspaikka on Kuopiossa, missd maanpinnan lumikuorman ominaisarvo on 2,5 kN/m? (KUVIO

2) ja tontin maastotyyppi on normaali, jolloin tuulensuojaisuuskertoimena kaytetdan arvoa 1,0 (TAU-

LUKKO 3). Nain ollen katon lumikuormaksi saadaan:

s=0,8%25kN/m?=2,0kN/m?

A
20 |
1.6
H2
g0+
0.8
1 "
" >
0° 15°  30°  45°  60°

KUVIO 1. Lumikuorman muotokertoimet (Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-

2017, 102)

TAULUKKO 3. Katon tuulensuojaisuuskertoimet (Rakenteiden kuormat. Suomen RakMK 2016, 17)

Maastotyyppi Ce
Tuulinen 0,8 (1,0, mikali lyhyempi sivumitta > 50 m)
Normaali 1,0
Suojainen 1,2

Tuulinen maasto: laakea, esteeton, joka puolelle avoin alue, jolloin maasto, korkeat
rakennuskohteet tai puut eivit suojaa tai suojaavat vain vahan.

Normaali maasto: alue, jolla rakennuskohteeseen vaikuttava tuuli ei maaston, muiden
rakennuskohteiden tai puiden takia huomattavasti poista lunta.

Suojainen maasto: alue, jolla tarkasteltava rakennuskohde on huomattavasti alempana
kuin ympardiva maasto tai se on korkeiden puiden tai itseddn korkeampien rakennus-
kohteiden ympardima.
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KUVIO 2. Lumen ominaisarvot maan pinnalla (Rakenteiden kuormat. Suomen RakMK 2016, 15)

3.4 Tuulikuorma

Tuulikuorma on muuttuva kiinted kuorma. Rakennusta ympardivd maasto jaetaan pinnanmuotojen

perusteella viiteen maastoluokkaan:

» Maastoluokka 0: Meri tai avoimen meren rannikko.

» Maastoluokka I: Jarvi tai alue, jolla on vahadista kasvillisuutta tai esteitd.

» Maastoluokka II: Alue, jolla on matalaa kasvillisuutta ja erillisia esteitd, jotka ovat
vahintdan esteen 20-kertaisen korkeuden etdisyydella toisistaan.

»= Maastoluokka III: Alue, jolla on saanndllinen kasvipeite, rakennuksia tai erillisia es-
teita, jotka ovat esteen 20-kertaista korkeutta Idhempana toisiaan (kylat, esikaupun-
kialueeet, pysyva metsa).

» Maastoluokka IV: Alue, jolla vahintdan 15 % alasta on rakennusten peitossa ja joi-
den keskimaaradinen korkeus ylittdd 15 metria.

(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 131.)

Tuulikuormat voidaan maarittad joko voimakerroin- tai painekerroinmenetelmalld. Hallin kokonais-
tuulikuorman maarittdmiseen kaytetdan tdssa tapauksessa voimakerroinmenetelmaa. Kokonaistuuli-
kuorman ominaisarvo nelitkuormana saadaan kaavasta:

Gwe = CsCq * Cp * qp(2)

missa cscd = rakennekerroin
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¢r = voimakerroin

gn(z) = tuulen nopeuspaine korkeudella z

Rakennekerroin cscq ottaa huomioon rakennuksen koon, mittasuhteet ja tuulen puuskien dynaamiset
vaikutukset. Kertoimena voidaan kayttaa arvoa 1, kun rakennuksen korkeus on alle 15 metria
(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 145). Rakennus kuuluu maastoluok-
kaan I ja sen kokonaiskorkeus on 11,8 metrid, joten nopeuspaineena kaytetaan arvoa 0,79 kN/m?
(TAULUKKO 4). Voimakerroin cr maaraytyy rakennuksen sivusuhteen ja tehollisen hoikkuuden mu-

kaan. Kun rakennuksen korkeus on alle 15 metrid, tehollinen hoikkuus A saadaan kaavasta:
A=2h/b

missa h = rakennuksen korkeus
b = rakennuksen leveys tuuleen nahden kohtisuoraan

(Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 140).

Kokonaistuulikuorman ominaisarvo neliokuormana hallin sivuseinaa vastaan:

/1_211,8m_048
T T491m
d_31,5m_064
b~ 491m

— voimakerroin ¢f= 1,42 (TAULUKKO 5)

Gwr = 1,0 * 1,42 % 0,79 kN /m? = 1,13 kN /m?

Kokonaistuulikuorman ominaisarvo nelitkuormana hallin paatyseinaa vastaan:

_211,8m_075
T 7315m
d_49,1m_156
b 315m

— voimakerroin ¢f = 1,16 (TAULUKKO 5)

Gwi = 1,0 ¥ 1,16 * 0,79 kN/m?* = 0,92 kN /m?
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TAULUKKO 4. Puuskanopeuspaine eri maastoluokissa (Suunnitteluperusteet ja rakenteiden kuormat:
RIL 201-1-2017, 137)

z(m) Maastoluokka
0 | I 1 v
0 0,66 042 0,39 0,35 0,32
1 0,66 0,42 0,39 0,35 0,32
2 0,78 0,52 0,39 0,35 0,32
5 0,96 0,65 0,53 0,35 0,32
8 1,05 0,73 0,61 0,43 0,32
10 1,09 0,76 0,65 047 0,32
15 1,18 0,83 0,72 0,55 0,40
20 1,24 0,88 0,77 0,60 0,45
25 1,29 0,92 0,82 0,65 0,50
30 1,33 0,95 0,85 0,68 0,54
35 1,37 0,98 0,88 0,72 0,57
| 40 1,40 1,01 0,91 0,74 0,60

TAULUKKO 5. Voimakertoimet (Suunnitteluperusteet ja rakenteiden kuormat: RIL 201-1-2017, 141)

Sivusuhde d/b

A o1 [ 02 [os [o7 | 1+ [ 2 | 5 [ 10| s
<1 1,2 1.2 1,37 1,44 1,28 0,99 0,60 0,54 0,54
3 1,29 1,29 148 1,55 1,38 1,07 0,65 0,58 0,58
10 | 140 | 140 | 160 | 168 | 149 | 115 | 070 | 063 | 063

3.4.1 Pistekuorma tuulesta pilarin yldpaan ylapuolella

Kehajako on 5,4 m ja pilarin ylapaan pystysuora etaisyys harjan tasalle 1,8 m. Tuulen resultantiksi

pilarin ylédpaan ylépuolella saadaan:

1,13kN/m? «5,4m = 1,8m = 10,98 kN

Pistekuorma siirretdan pilarin paahén momenttiyhtalén avulla:

’

m
10,98kN*<10m + >=H2*10m—>H2=11,97kN

3.4.2 Katon kitkan aiheuttama tuulikuorma paatypalkin tasossa

Pinnan suuntaisesti vaikuttava kitkakuorma saadaan kaavasta:
Afrk = Qp(z) * Cpp * Lfr

missa crr = kitkakerroin, joka on huopakatolla 0,02

Ls = kitkakuorman vaikutuspituus

Kitkakuorman vaikutuspituus saadaan véhentamalla hallin pituudesta min[2b; 4h], jossa b = hallin
leveys ja h = hallin korkeus. Tassa tapauksessa hallin pituuteen otetaan mukaan laajennusosa. Vai-

kutusalueen pituudeksi harjan suunnassa saadaan:
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Ly =74m —4%x11,8m =268m

Katon kitkan aiheuttamaksi tuulikuormaksi paatypalkin tasossa saadaan:

prie = 0,79 kN /m? % 0,02 * 26,8 m = 0,43 kN /m

Kehan epatarkkuudet

Kehan epatarkkuudet otetaan huomioon asettamalla kehanurkkiin ekvivalentit vaakavoimat, jotka
ovat suoraan verrannollisia epatarkkuuden ja pilarin normaalivoiman kanssa. Vinous ® saadaan kaa-

vasta:
D =Dy *ay *ay,

missa ®o = vinouden perusarvo = 1/200
an = pilareihin sovellettava korkeuden (h) pienennystekija:

2
a, =— mutta - < a, <1,0
h i 3 h

am = pienennystekija, joka ottaa huomioon rivissa olevien pilarien (m) lukumaaran:
1
Ay = 0,5 <1 + H)
Vinouden arvoksi saadaan:

® Lz 0,5 <1 + 1) !
= * — % - =
200 3 ’ 2 346,41

Ekvivalentit vaakavoimat saadaan kertomalla pilarin normaalivoima vinoudella ® (KUVIO 3). Raken-
teiden omapainosta aiheutuva pilarin normaalivoima kdyttorajatilassa on 151,4 kN ja lumikuormasta
aiheutuva 200,9 kN. Nain ollen pilarin yléapadhan asetettaviksi vaakavoimiksi kayttdrajatilassa saa-

daan:

omapainosta:

34641 *151,4 kN = 0,437 kN

lumikuormasta:

34641 *200,9 kN = 0,58 kN
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KUVIO 3. Alkuepatarkkuuksien korvaaminen ekvivalenteilla vaakavoimilla (Eurokoodi 3: Terasraken-

teiden suunnittelu)

3.6  Nosturikuormat

Halliin tulevasta siltanosturista ei ole toistaiseksi tarkkoja tietoja. Taman esimerkin nosturi vaatii pila-

rilinjan hallin sisdlle. Nosturin aiheuttamien kuormien laskemisessa kaytetdan seuraavia lahtdéarvoja:

» nosturin jannevali: 13 m

» kuorman minimietdisyys ratapalkista: 1,0 m
» nosturin pyorien vali: 2,0 m

= nosturin sillan paino Qci: 2,8 kN/m

= nosturin nostovaunun paino Qcz: 8,0 kN

= nosturin kokonaiskuorma Qn: 50 kN

» nostoluokka HC3

= vakionostonopeus vh = 6 m/min

Nosturin aiheuttamat kuormat jaetaan kuormaryhmiin 1-10 (TAULUKKO 6). Tassa opinndytetydssa
lasketaan ryhmat 1, 5 ja 6, koska muut kuormaryhmat eivat tule olemaan pilarien yhteydessa mitoit-
tavia. Varahtelyistd, hidastuksista ja iskuista aiheutuvat dynaamiset vaikutukset huomioidaan dynaa-

misuuskertoimilla, jotka ovat tassa tapauksessa:

" =11
= p,=12
= ;=10
= 9,=10

- (pS = 115
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TAULUKKO 6. Kuormaryhmat ja niiden dynaamisuuskertoimet (Eurokoodi 1: Rakenteiden kuormat)

Kuormaryhmét
Merkintd | Kohta Murtorajatila Koe- Onnettomuus-
kuorma | Kuorma

1 2 3 4 5 6 7 8 9 10
1 [Nosturin oma paino Q. 2.6 [ I 1 O |04 @ |1 [ 1 1
2 | Kokonaiskuorma &, 2.6 [ - o e e |7 ) |- 1 1
3 | Nosturisillan kiihdytys Hy, Hy 2.7 [ o @ |- - - [0 3 - -
4 | Nosturisillan vinoon ajo Hg 2.7 - - - - 1 - - - - -
5 | Nostovaunun tai riippunos- | Hra 2.7 - - - - - 1 - - - -

timen kiihdytys tai jarrutus

6 | Kayton aikainen tuuli Fa* Liite A 1 1 1 1 1 - - 1 - -
7 | Koekuorma Cy 210 - - - - - - - [ - -
8 | Puskinkuorma Hg 2.1 - - - - - - - - @
9 | Térmayskuorma Hya 2.1 - - - - - - - - - 1
HUOM. Ks. liitetta A tuulikuorman osalta, kun nosturi ei ole kdytossa.
1 77 on jéljelle jaavan kokonaiskuorman osuus, kun taakka poistetaan. Osuus ei sisélla nosturin omaa painoa.

3.6.1 Minimipyordakuormat

Kuormaryhmalle 1:

Qcix = @1 %Qcy = 1,1+ 2,8kN/m = 3,08kN/m
Qc2k = 91 * Q2 = 1,1« 8kN = 88 kN

20 (miny = 0,5 % 3,08 kN /m * 13 m + 8,8 kN * 12m/13 m = 28,15 kN = Qy nin) = 14,08 kN
Y Qrmin = 0,5 % 3,08 kN/m * 13 m + 88 kN x 1 m/13m = 20,70 kN = Qypnin = 10,35 kN

Kuormaryhmille 5 ja 6:

Qcik = Pa*Qcy = 1,0 2,8kN/m = 2,8 kN/m
ch,k =@y *Qr, =10+«8kN =8kN

20 (miny = 0,5*2,8kN/m*13m+ 8 kN =« 12m/13m = 25,59 kN - Q; (nin) = 12,80 kN
YQrmin =05%28kN/m+13m+8kN *1m/13m = 18,82 kN — Q; jpin = 9,41 kN

QLI‘I’II‘I Qr.miu 'Z'Dr.mn iy Qr. {min) i:‘:‘]-r.ﬂlrinl

= ! e | St

= = : |:|-\ =
I

7

A A

KUVIO 4. Minimipy6rakuormat (Eurokoodi 1: Rakenteiden kuormat)
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3.6.2 Maksimipyérakuormat

Kuormaryhmalle 1:

Qni =92 *Qp =12+50kN = 60 kN

Y Qrmax = 28,15 kN + 60 kN * 12 m/13 m = 83,54 kN = Qy pmax = 41,77 kN
Y0 (maxy = 20,7 kN + 60 kN * 1 m/13 m = 2532 kN = Qygnax) = 12,66 kN

Kuormaryhmille 5 ja 6:

Qni = ¢3*Qn = 1,0 x50 kN = 50 kN

Y Qrmax = 25,59 kN + 50 kN * 12 m/13 m = 71,75 kN = Q, ynqx = 35,88 kN
Y.0r (max) = 18,82 kN + 50 kN * 1 m/13 m = 22,67 kN = Qy (max) = 11,34 kN

2

mach £, )

T )

H + O

{E
H;]])

N
O]
2
£
S I_I\

KUVIO 5. Maksimipy6rakuormat (Eurokoodi 1: Rakenteiden kuormat)

3.6.3 Nosturisillan kiihdytyksesta ja jarrutuksesta aiheutuvat vaakavoimat

Nosturisillan kiihdytyksestd ja jarrutuksesta aiheutuvat vaakavoimat huomioidaan kuormaryhmassa
1. Ajovoima K kuormaryhmalle 1, kun nosturissa on kaksi (mw = 2) ajokoneistoa ja kitkakerroin p =
0,2 saadaan kaavasta:

K=pu*YQumn=u*my *Qrmin =02x2%10,35kN = 4,14 kN

Radan suuntainen vaakavoima, kun ratapalkkien lukumaara nr = 2:
H,=H,=¢s*K/n,=15%414kN/2 = 3,11 kN

Rataa vastaan kohtisuorat vaakavoimat:

2X0-=% Qr,max +2 Qr,(max) = 83,54 kN + 25,32 kN = 108,86 kN

& =Y Qrmax /Y Qr = 83,54 kN /108,86 kN = 0,78, &, = 1 — &, = 0,22
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ly,=(5—-05)+1=(078—0,5)*13m =3,64m
M=K=xl;, =414 kN * 3,64 m = 15,07 kNm

Hri=@s+&*M/a=15%0,22%1507 kNm/2m = 2,49 kN, missa a = nosturin pydrien vali
Hr, =@s+& *M/a=15%0,78+15,07 kNm/2 m = 8,82 kN

2
|
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KUVIO 6. Nosturisillan kiihdytyksesta ja jarrutuksesta aiheutuvat vaakasuuntaiset pyérakuormat (Eu-

rokoodi 1: Rakenteiden kuormat)

3.6.4 Nosturisillan vinoonajosta aiheutuvat vaakavoimat

Nosturisillan vinoonajosta aiheutuvat vaakavoimat huomioidaan kuormaryhmdassa 5.

Vierintakitkakerroin f saadaan kaavasta:

f=03x%(1-exp(—250 xa)) < 0,3, missa a = 0,008 rad
£ =03 (1— exp(—250 = 0,008)) = 0,259 < 0,3

A-arvojen laskeminen:

e1 = 0 (pyoraparin etdisyys suunnanohjauslaitteesta)

€2 = a = 2 m (py6raparin etdisyys suunnanohjauslaitteesta eli edelld olevan pydran laipasta)
Erillisilld ajokoneistoilla yhteenlaskettujen ajokoneistojen lukumdara m = 0, jolloin hetkellisen kaan-
tokeskion etdisyys ohjauslaitteestah=a =2 m.

As=1-Ye /(m*xh)=1-2m/(2*2m) = 0,5, missa n = py6raparien lukumaara = 2

Pyoraparille 1:

Asiar = (§2/m) * (1 —e/h) = (0,22/2) » (1 -0) = 0,11
Aszar = (§1/n) * (1 — e /h) = (0,78/2) * (1 - 0) = 0,39

/15,1,1,L = /15,2,1,L =0
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Pyoraparille 2:

Asizr = (§2/n) * (1 —ey/h) = (0,22/2) x (1 —2m/2m) =0
Asz2r = (§1/n) x (1 —ey/h) = (0,78/2) x (1 —2m/2m) =0

15,1,2,14 = AS,Z,Z,L =0

Radan pituussuuntaiset vaakavoimat:

Hs11, = Hsp20 = Hs210 = Hsp20 =0

Rataa vastaan kohtisuorat vaakavoimat kuormaryhman 5 py6raparille 1:
Y0 = X0Qrmax + 2Qr(max) = 71,75 kN + 22,67 kN = 94,42 kN

S=fxA +Y0Q, = 0259 0,5« 94,42 kN = 12,23 kN
Hsrlrer = f * AS,LI,TZQT = 0,259 * 0,11 * 94,4’2 kN = 2,69 kN
Hgp1r = f * A2 1750r = 0,259 0,39 + 94,42 kN = 9,54 kN

Pyoraparille 2:

HS,I,Z,T = f * AS.]..Z.TZQT = 0,259 * 0 * 94,42 kN = 0
HS,Z,Z,T = f * AS,Z,Z,TZQT = 0,259 * 0 * 94’,42 kN = 0

1

3
I
L

—» [j#q—s
H5,1,1,1 I

2
I
i m— Tt

HS,?,‘I, f

KUVIO 7. Vinoonajosta aiheutuvat vaakasuuntaiset pyorakuormat ja ohjauskuorma S, kun suunnan-

ohjaus toimii pydran laippojen avulla (Eurokoodi 1: Rakenteiden kuormat)

3.6.5 Nostovaunun kiihdytyksesta ja jarrutuksesta aiheutuvat vaakavoimat

Nostovaunun kiihdytyksesta ja jarrutuksesta aiheutuvat vaakavoimat huomioidaan kuormaryhmassa
6. Nostovaunun kiihdytyksesta ja jarrutuksesta aiheutuvaksi vaakavoimaksi oletetaan vahintaan 10
% nostovaunun ja hydtykuorman arvosta. Olettaen, etta pyorissa on laippa vain toisella sivulla, vaa-

kavoima yhdelle pydralle saadaan kaavasta:

Hrs =0,1(Qcs + Q) = 0,1 % (8kN + 50 kN)/2 = 2,9 kN



3.6.6 Yhteenveto nosturikuormista

Nosturin aiheuttamat kasin lasketut kuormat on esitetty taulukossa 7. Pydrakuormat on tarkastettu
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my®s Ruukki RAPALKKI -ohjelmalla. Jokaista kuormaryhmaa kasitelladn yhtena kuormituksena yh-

distettdessa nosturikuormia muihin ei nostureista aiheutuviin kuormiin (Suunnitteluperusteet ja ra-
kenteiden kuormat: RIL 201-2-2017, 137). Nosturia kannattelevien rakenteiden osalta nosturikuor-

mat ovat muuttuvia kuormia. Kuormien mitoitusarvot nosturikuormien osalta on esitetty taulukossa

8. Yksittdisen nosturin tai nosturikuormien ryhman yhdistelykertoimina kaytetaan arvoja:

wo=1,0
W1=0,9

Y2 = pysyvan nosturikuorman suhde nosturin aiheuttamaan maksimikuormaan

(Eurokoodi 1: Rakenteiden kuormat).

TAULUKKO 7. Nosturin aiheuttamat ominaiskuormat

Kuormaryhma 1 5 6
Dynaamisuuskerroin wi=1,1 | w4+=1,0 | Y4=1,0
y=1,2
w3=1,5
Pystykuormat Nosturin omapaino Qr,(min) 14,08 12,8 12,8
Qr,min 10,35 9,41 9,41
Nosturin omapaino + Qr,(max) 12,66 11,34 11,34
hyétykuorma Qr,max 41,77 | 35,88 | 35,88
Vaakakuormat | Nosturin kiihdytys ja Hi,1 3,11 - -
jarrutus HL2 3,11 - -
Hr,1 2,49 - -
Hr.2 8,82 - -
Nosturin vinoonajo S - 12,23 -
Hs,1,1,.= Hs12L | - 0 -
Hs2,1,.= Hs2,2L | - 0 -
Hs,1,1,7 - 2,69 -
Hs2,1,1 - 9,54 -
Hs,1,2,T - 0 -
Hso2,21 - 0 -
Nostovaunun kiihdytys | Hr3 - - 2,9
ja jarrutus

TAULUKKO 8. Kuormien mitoitusarvot nosturikuormien osalta

RakMK 2016, 49)

(Rakenteiden kuormat. Suomen

Normaalisti vallitsevat ja tilapaiset mitoitustilanteet

Yht.6.10a Yht.6.10b

Pysyvat kuormat Epaedulliset 135K G0 115K G
Edulliset 1,0Gy 7 1,0G, r

Jos nosturikuorma on maaraava muuttuva kuorma 1,35K5 05

Jos nosturikuorma on muuta samanaikaista muuttuvaa kuormaa

1,35K e o1 Oxs
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3.7 Kattoristikon kuormat kdyttorajatilassa

= k= 2-aukkoisten kantavien poimulevyjen jatkuvuuden huomioiva kerroin = 1,2
» s =kehdjako =54 m

» gk = ylapohjarakenteen omapaino + ripustuskuorma = 0,973 kN/m?

* Qi = katon lumikuorma = 2,0 kN/m?

= gp(2) = tuulen nopeuspaine = 0,79 kN/m?

Laskentaohjelma ottaa huomioon ristikon omapainon. Ylapohjarakenteen omapainosta aiheutuva

metrikuorma:

Pk,g:k*s*gkl

Py =1,2%54m+0,973 kN/m? = 6,31 kN /m

Lumesta aiheutuva metrikuorma:

Pk,q1=k*5*Qk1

Pegr = 1,2 #54m* 2,0 kN/m? = 12,96 kN/m

Terdsrakenteiden suunnittelu ja mitoitus -oppikirjan liitteen L10.1 mukaan kattoon kohdistuvan tuuli-

kuorman oletetaan vaikuttavan kohtisuoraan kattoa vasten. Katon tuulikuorma metrikuormana:

Pk,qz =k*s* Qp(z)
Prg2 =12%54m=0,79 kN/m? =512 kN/m

3.8 Paatyseinan vinositeessa vaikuttava voima

Tuulen vaikutusala pitkalla sivulla:

10m

Aref,sivu =49,1m* < +1,8 m) = 333,88 m?

Paatyseinalle kohdistuva vaakavoima:
1,0 * 1,42 * 0,79 kN /m? = 333,88 m?/2 = 187,3 kN
Paatyseinan jaykistyssauvassa vaikuttava voima murtorajatilassa, kun sauvoja on kaksi:

187,3 kN
, Cos 65,44°

= N
> 338k

1,5
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10.15

30.75
I \

KUVA 8. Padtyseinan vinositeessa vaikuttava voima

Tulevaisuudessa hallia on tarkoitus laajentaa pituussuunnassa noin 25 m. Tuulen vaikutusala laajen-

nuksen osalla:

Om

1
25,1m« ( +1,8 m) = 170,68 m?

Valiseindlle kohdistuva vaakavoima:
1,0 x 1,42 % 0,79 kN /m? x« 170,68 m?/2 + 187,3 kN = 283 kN
Viliseinan jaykistyssauvassa vaikuttava voima murtorajatilassa, kun sauvoja on kaksi:

283 kN
, Cos 65,44°

> = 510,7 kN

1,5

Jaykistavan vinositeen kautta pilarianturalle valittyva voima on 510,7 kN. Vaikka keskimmaiset pilari-
anturat yhdistetdan toisiinsa peruspilarien valiin valettavalla betonipalkilla, omapainoista aiheutuva

momentti ei riitd kumoamaan vinositeessa vaikuttavan voiman aiheuttamaa momenttia.
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4 RAKENNEOSIEN MITOITUS

FEM-Designiin tuotavaan laskentamalliin valittiin Tekla-mallista teraksiset rungon osat lukuunott-
matta poimulevyja. Vertailun vuoksi keskeiset rakenneosat mitoitetaan seka levy- etta mastopilari-
jaykistyksella. Ennen rakenteiden mitoitusta on tarkastettava, ettd rakenneosien paiden tukiolosuh-
teet vastaavat todellista tilannetta. Pilarien tuet ovat pistetukia, jotka lisatdan kohdasta “Point sup-
port group”. Tuen asetuksissa tukityypiksi valitaan levyjaykistyksessa "Hinged” eli nivelellinen ja

mastopilarijaykistyksessa “Rigid” eli jaykka.

Rakenneosien padiden vapautukset maaritetdan kyseisen osan asetuksissa “End conditions” -valileh-
delld. Kattoristikon ylapaarteen ja pilarin liitos on molemmissa jdykistystapauksissa nivelellinen. Risti-
kon sauvojen oletetaan liittyvan jaykasti paarteisiin, jolloin tukiolosuhteeksi valitaan “Rigid”. Jaykis-
tava levykentta voidaan lisata “Profiled plate” -tydkalulla. Ohjelman profiilikirjastosta ei 10ydy oletuk-
sena terdspoimulevya, mutta profiili voidaan luoda “Section Editor” -tyokalulla. Ulkoseindt peitetdan

lopuksi “Cover” -toiminnolla, jolloin seinien tuulikuorma on mahdollista lisété nelibkuormana.

4.1 Kuormien lisdaminen

Laskentamallin korjaamisen jalkeen lisatdan kuormat kohdasta “"Load cases”. Ensimmaiseksi kuor-
matyypiksi laitetaan "+Struc. dead load”, jolloin ohjelma lisda automaattisesti rakenteiden omapai-
not. Muita kuormatyyppeja ovat Ordinary, Soil dead load, Shrinkage, Camper sim., Fire ja Seis load.
Kéytanndssé kuormatyypiksi valitaan aina Ordinary, kun kuorma ei kuulu muihin tyyppeihin. Kuor-
man kestoksi voidaan valita pysyva, pitkaaikainen, keskipitka, lyhytaikainen tai valitdn. Kuormat lisa-
tdan "“Point load”, “Line load” ja “Surface load” -toiminnoilla. Tuulikuormien lisédmiseen voidaan
kayttéa myds "Generic building” -macroa, joka lisaa tuulen aiheuttamat paine- ja imutapaukset ne-

libkuormina rakennuksen sivuille ja katolle.

KUVA 9. Pitkan sivun tuulikuorma lisdtty neliokuormana
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Kun kaikki kuormat on syétetty, tehdaan tarvittavat kuormitusyhdistelyt “Load combinations” -toi-
minnolla. Ohjelmassa on nelja eri tyyppista kuormitusyhdistelmaa; murtorajatila (U), onnettomuus
(Ua), maanjaristys (Us) ja kdyttorajatilat (S). Mikali halutaan, etta ohjelma tekee yhdistelyt auto-
maattisesti, on ensin tehtava kuormaryhmat kohdasta “Load groups”. Siella jokaiselle kuormaryh-
malle maaritetdan kuormatyyppi, osavarmuusluvut ja muuttuville kuormille kuormien yhdistelykertoi-
met. Valittavia kuormatyyppeja ovat Permanent, Stress, Temporary, Accidental ja Seismic. Pysyvien

kuormien kuormatyypiksi valitaan Permanent ja muuttuvien kuormien tyypiksi Temporary.

4.2 Mitoitus

Terasrakenteiden mitoitus tehddan “Steel design” -valilehdella. Mitoituslaskenta suoritetaan valitse-
malla “Calculations > Design calculations”. Toisen kertaluvun laskenta saadaan valitsemalla "“Calcu-
lations > Analysis > Load combinations > Setup by combinations...” ja valitsemalla halutun kuormi-
tusyhdistelman kohdalta “2nd order analysis”. Mitoituslaskennan jalkeen poikkileikkauksia paastaan
muuttamaan valitsemalla "Manual design”, josta saadaan ndkyviin lista rakenneosista ja niiden kayt-
toasteista. Profiilien muuttamisen jalkeen laskenta on suoritettava uudestaan valitsemalla “Recalcu-
late”. Taipumia paastaan tarkastelemaan valitsemalla “New result > Load combinations > Translati-
onal displacement” ja valitsemalla kayttorajatilan kuormitusyhdistelma. Siirtymien ja taipumien las-

kennassa huomioidaan 2. kertaluvun vaikutukset.

4.3  Siirtymien raja-arvot ja mitoituksen tulokset

Ristikon taipumaraja:

L/300 = 31000 mm/300 = 103 mm

Pilarien vaakasiirtymien raja-arvo:

H/150 = 10000 mm/150 = 66,6 mm

Nosturikuormista aiheutuva kehan tai pilarin vaakasuuntainen siirtymaraja nosturin tuen tasolla:

h./400 = 7000 mm /400 = 17,5 mm

4.3.1 Kattoristikko

Kattoristikko mitoitetaan ilman poimulevya, jolloin ylapaarretta tukee sivusuunnassa paarteiden va-
lissd olevat sauvat. Laskentamalliin lisatadn tassa tapauksessa vain pystykuormat. Mitoittavaksi
kuormitusyhdistelmaksi tulee lumi padkuormana: 1,15 * omapaino + 1,5 * lumi + 1,5 * 0,6 * tuuli.
Taipuma on esitetty kuvassa 10. Sauvan kayttdaste on reunimmaisesta sauvasta.

Kattoristikon terasprofiilien poikkileikkauksiksi ja kayttoasteiksi saadaan:



=  Ylapaarre 200x200x10, kdyttoaste 94 %
= Alapaarre 180x180x8, kayttdaste 84 %
= Sauva 180x180x8, kayttdaste 93 %
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Utilization

Group Applied profile

KKR 20020010

¥ Sauva KKR 180x180x8
+ Alapaarre KKR 180x180x8

KUVA 10. Ristikon taipuma ja kayttoasteet

4.3.2 Levyjaykistys

Pilarin 1. kertaluvun momentti nakyy kuviossa 8. Sivuseinan pilarin mitoittavaksi tekijaksi tulee nor-

maalivoiman ja taivutuksen yhteisvaikutus (KUVIO 9). Kun jaykistystapana on levyjaykistys, profii-

leiksi saadaan:

= sivuseindn pilari HE-A 300
= paatyseinan tuulipilari HE-A 260
= paatyseinien vinositeet 200x200x12,5

= sjvuseinien vinositeet 160x160x8

116
LC8

—

KUVIO 8. Pilarin 1. kertaluvun momentti
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Summary

4 Utilization [%]
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KUVIO 9. Pilarin HE-A 300 mitoitustarkastelujen kayttéasteet

o
.

Interaction between normal force and bending 2. - Part 1-1: 6.3.3
Bar: C.18.1, LC: "1.15"Omapaino + 1.50"0.70"Lumi + 1.50"T uuli sivusein& + 1.35"Nosturi kuormaryhmé €', x= 5225 mm

Class NS 3, Class w = 3, Class w2 = 3

k i factors are calculated according to Method 2

a = 0.00 1] = 1.00 = 095
my my my
a = 1.00 W = 0.00 C = 0.60
mz mz mz
a wLT = 0.00 1] mLT = 1.00 C mLT = 095
M SRE - f‘,r - W amin2 - 355 - 420637 = 149.33 kN m
comp
Ed P M kg . K . M ey _
21 22 -
N bRz M y.b.Rd M ;e
Y 1
468.46 116.25 0.83
= -+ 0% -— — _+ 070 -— =
1648.43 232.89 149.33
1.00
= 078 < 1.00 (6.62) -0OK

4.3.3 Mastopilarijdykistys

Mastopilarikehdn 1. ja 2. kertaluvun momentit nakyvat kuvioissa 10 ja 11. Mastopilarin maaréavaksi
tekijaksi tulee sivusiirtymd (KUVIO 12) ja muiden mitoitustarkastelujen kayttdasteet nakyvat kuvi-

ossa 13. Kun jaykistystapana kehan suunnassa on mastopilarijaykistys, profiileiksi saadaan:

= sivuseindn mastopilari HE-B 400

= paadtyseinan tuulipilari HE-A 260
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KUVIO 10. Mastopilarikehan 1. kertaluvun momentit
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KUVIO 11. Mastopilarikehan 2. kertaluvun momentit
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KUVIO 12. Mastopilarikehén sivusiirtyma
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Summary
4 Utilization [%]
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KUVIO 13. Mastopilarin HE-B 400 mitoitustarkastelujen kayttdasteet

Interaction between normal force and bending, 2nd order - Part 1-1: 6.3.3
Bar: C.18.1, LC: "1.15"0Omapaino + 1.50%0.70*Lumi + 1.50*Tuuli sivuseina + 1.35*Nosturi kuormaryhma &', x=0mm

C|E3.55 N = 1! ClElSS M1 = 1’ C|E155 w2 - 1
N comp M M
Ed 1,Ed ZEd
+ + =
N o M v.b.Rd M 2 ra
45922 478.38 0.01
_ ) N = 057 < 1.00 (661) -OK

7021.11 946.44 382.02
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5 YHTEENVETO JA POHDINTA

Opinnaytety6n tavoitteena oli suunnitella alustavasti konepajahallin kantavat rakenteet. Aihe kasitti

kuormien laskemisen, rakennemallin tekemisen ja sen siirtdmisen FEM-ohjelmaan seka itse rakenne-
osien mitoituksen. Aikaisempi kokemus suunnitteluohjelmien kayttamisesta ja terasrakenteiden opis-
kelusta antoi pohjan opinndytetyon tekemiseen. Haasteellista tydssa oli Tekla-mallin siirtdminen las-
kentaohjelmaan ja rakenteiden mitoittaminen FEM-Design 3d Structuressa, koska niiden kaytdsta oli
vahan kokemusta. Halli on vasta alustavasti suunnitteilla, joten lopullisia rakennesuunnitteluun tar-

vittavia lahtotietoja ei ollut tiedossa. Tarkkoja tietoja ei ollut esimerkiksi siltanosturista, vaan nosturi-

kuormien laskemisessa kaytettiin esimerkkinosturin mittoja.

Opinnaytetytssa perehdyttiin jaykistystapaan, jossa kantavat poimulevyt toimivat jaykkana levykent-
tana ja siirtdvat rakennuksen pitkalle sivulle kohdistuvat vaakavoimat paatyseinien vinositeille. Vino-
siteessa vaikuttavan voiman laskemisessa on huomioitava, etta hallia on tarkoitus laajentaa tulevai-
suudessa pituussuunnassa. Hallin pituus johtaa siihen, etté vinositeen kautta perustukselle tulee
suhteellisen suuri voima, joka pyrkii vetamaan pilarianturan ylds. Paatyseinan pilarille ei tule merkit-
tadvaa pystykuormaa, joka estéisi perustuksen nousemisen. Mydskaan keskimmaisten pilarianturoi-
den yhdistédminen toisiinsa ei riitd, joten suositeltava jaykistystapa tdssa tapauksessa on mastopilari-

jaykistys.

Opinnaytety6 antaa tilaajalle alustavan suunnitelman konepajahallin rakenteista. Rakennemalli ha-
vainnollistaa rakenteiden sijainnit ja poikkileikkausten suuruusluokat. Itselle tyd antoi kokemusta
terasrakenteiden suunnittelusta ja etenkin FEM-Design 3d Structuren kdyttamisesta. Mydskaan nos-

turikuormien laskemisesta ei ollut aikaisempaa kokemusta.
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